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Summary 

This document is intended to provide a reference document in order to generate signals for an EL lamp driver in 
S1C17W23 by using IR remote controller (REMC) and turn on the EL lamp. 

 
Operating Environment 

• S5U1C17W23T (Software Evaluation Tool for S1C17W23, "SVT17W23" below) 
A dedicated cable is necessary to connect to ICDmini. 

• PC 
- GNU17 (S5U1C17001C) development tool already installed* 
- ICDmini USB driver already installed 

• ICDmini (S5U1C17001H) 
A USB cable is necessary to connect to PC. 

• Programming package (this package) for S1C17W23 EL lamp driver 
- Programming package for conditional running in RAM 
- Programming package including a test assembler 

 

*Note: This package has been evaluated in GNU17 v2.4.0/v3.0.5. 
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1. Specification 
 
 

1. Specification 

In this application notes, the signals for the EL lamp driver are generated by using an IR remote-controller 
(REMC) built in S1C17W23. The signals generated for the EL lamp driver are input into high voltage DC-DC 
converter circuit mounted on a separate board to generate high voltage to turn on the EL lamp. 

Of all programs, W23_REMC_RAM_gnu17vx, which runs on RAM in order to set wave conditions for EL drive 
signals and make an experiment of REMC, is to generate signals for the EL lamp driver continuously during the 
operation. 

Also, W23_REMC_ASM_gnu17vx including a test assembler out of all sample programs is to generate signals 
for the EL lamp driver for one of turn-off/turn-on/blink operation modes. 

The figure 1 shows how to connect the circuit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1  How to connect SVT17W23 - High voltage DC-DC converter circuit 
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2. Feature Description 
 
 

2. Feature Description 

Output pin REMC's REMO: CHG signal (for generating charging pulses) 
GPIO's P00: DIS signal (for generating discharging pulses) 

Operation mode REMC: Controls when to restart REMC in one-shot mode in order to invert DIS signals and 
output CHG signals by using compare AP/DB interrupt functions. 

System clock The system clock uses OSC1 (32.768kHz). 

Interrupt The REMC's vector number and vector address are as follows: 
 
REMC Vector No.: 21 (0x15) 
 Vector address: 0x1054 (W23_REMC_RAM_gnu17vx), 
  0x8054 (W23_REMC_ASM_gnu17vx) 
 
This sample uses the following two types of interrupts. 
- Compare AP interrupt 
- Compare DB interrupt 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2  REMC configuration 

 
 
 
 

2  Seiko Epson Corporation S1C17W23 EL Lamp 
Application Notes (Rev. 1.1) 



3. Operating Principle 
 
 

3. Operating Principle 

(1) EL 

EL stands for Electro-Luminescence, a luminous phenomenon caused when a substance is excited by energy. The 
phenomenon is called luminescence that emits the energy as light which a fluorescent substance received from 
excitation source. The luminescence is, according to types of excitation sources, classified into 
electro-luminescence (EL) excited by electric field, photo-luminescence (PL) excited by light, and 
cathode-luminescence (CL) excited by electron beam. 

EL is classified into injection and intrinsic ELs according to luminescent principle. And, strictly speaking, 
intrinsic EL may be called EL. The injection EL (distributed EL) emits light when electrons and holes injected 
into semiconductor element recombine near the junction surface by applying a voltage to electric field. The light 
emitting diode (LED) is an example of injection EL. The intrinsic EL (thin film EL) emits light when electrons 
accelerated by electric field collide with luminescent center and luminescent center is excited in semiconductor 
element. The thin film EL element is classified into this. 

The thin film EL elements are characterized by the fact that they emit light evenly and extensively over the entire 
surface of luminous plate of approximately 0.5mm thickness. The study of EL for lighting use and EL display is 
growing. The EL which uses organic substance including diamines as a luminous object is called organic EL and 
the EL which uses inorganic substance including zinc sulfide is called inorganic EL. 

The organic EL emits light at 5 to 10 VDC, but inorganic EL needs 50 to 200 VAC. This application notes 
describe how to generate necessary high voltage AC in order for inorganic EL to emit light. 

 

S1C17W23 EL Lamp Seiko Epson Corporation 3 
Application Notes (Rev. 1.1) 



3. Operating Principle 
 
 

(2) Principle of high voltage DC-DC converter 

The high voltage to activate EL is generated by applying driving waveform shown in Figure 4 to high voltage 
DC-DC converter circuit shown in Figure 3. In particular, two operating phases are repeated: the phase charging 
the EL lamp EL1 with high voltage generated in coil L1 by inputting CHG signals (signals for generating 
charging pulses) and the phase discharging the EL lamp EL1 by inputting DIS signals (signals for generating 
discharging pulses). 

Deliberately select the inductance of coil L1 and frequency of charge waveform input into CHG so that the 
luminescence intensity of EL lamp EL1 is maximized. 

When the current flowing in coil L1 increases from zero to I [A], the energy U [J] stored in coil L1 can be 
derived from the equation below based on the self-induction principle: 

 
 
 
 
 

Where, L is the inductance of coil L1, R is the resistance of coil L1, VQ1 is voltage between the collector and 
emitter when transistor Q1 is turned on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3  High voltage DC-DC converter circuit 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 4  Driving waveform of high voltage DC-DC converter 
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3. Operating Principle 
 
 

As shown in this equation, in order to maximize the energy generated from coil L1, it is necessary to increase 
supply voltage Vcc as much as possible and reduce resistance R of coil L1 as low as possible. 

The current flowing in a coil changes according to time and is determined by the turn-on time tON of a switch 
between the coil and power source as shown in the equation below: 

 
 
 
 

Where, VL is the voltage applied to coil L1. 

The current I flowing in a coil is zero at the moment when the switch is closed, and the voltage Vcc-VQ1 is 
applied to the coil. The current flowing in the coil increases linearly according to time from the switch-on. As the 
current flowing in the coil increases, the voltage applied to the inductor decreases due to the resistance of coil and 
switch's on-resistance, as shown in the equation 4 below: 

 
 
 
 

Thus, in order to generate high voltage for activating EL lamp without loss, it is necessary to select those 
high-voltage transistors and diodes which are sufficient for the drive voltage. 
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4. Software Description 
 
 

4. Software Description 

4.1 W23_REMC_RAM_gnu17vx 

This section describes W23_REMC_RAM_gnu17vx, the software running on RAM, in order to make an 
experiment on REMC by setting the waveform conditions of the EL drive signals. 

 
4.1.1 File Configuration 

File name Function 

src/boot.c Startup module 

src/main.c Main function 

src/osc.c OSC driver file 

src/osc.h OSC driver header file 

src/remc_out.c Initialize and interrupt functions of REMC waveform output 

src/remc_out.h Header file for the initialize and interrupt functions of REMC waveform output 

src/remc.c REMC driver file 

src/remc.h REMC driver header file 

src/crt0.h Boot processing definition file (for GNU17 Version 3) 

inc/c17w23_reg.h Header file for peripherals 

inc/reg The header file which defined the bit assignment every peripheral circuits 

 
4.1.2 Module Description 

This section describes non-generic setting mainly of function names and functions out of all modules in the files. 

 

File name: boot.c 

Function name Function 

boot In order to store programs in the RAM area with start address 0x1000, the 
Vector Table Address Low value is changed to 0x1000. 

 

File name: remc_out.c 

Function name Function 

remcInt REMC interrupt function. It handles the compare AP/DB interrupts. 

initStartRemc Initializes REMC. 
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4. Software Description 
 
 

4.1.3 Operating Procedures 

The sample software includes two projects for GNU17 Version 2 (hereinafter referred to as GNU17v2) and 
GNU17 Version 3 (hereinafter referred to as GNU17v3). 

(1) Select [Import...] from the [File] menu to start the Import Wizard, then select  

 [General] > [Existing Project to Workspace] (GNU17v2) or  

 [General] > [Existing Projects into Workspace] (GNU17v3).  

(2) Select the project folder that contains the sample program: 

 W23_REMC_RAM_gnu17v2 folder (GNU17v2) or 

 W23_REMC_RAM_gnu17v3 folder (GNU17v3). 

(3) Select [Copy projects into workspace] and then click the [Finish] button to exit the Import Wizard. 

(4) Change the target CPU.  

 (GNU17v2) 

1. Select the imported project in the [C/C++ project] view and select [Properties] from the [Project] menu. 

2. Select [GNU17 General] from the property list in the [Properties] dialog box that appears.  

3. Select the target CPU from the [Target CPU Device] drop-down list. 

4. Click the [OK] button to close the dialog box. 

 (GNU17v3) 

1. Select the imported project in the [Project Explorer] view and select [Properties] from the [Project] 
menu. 

2. Select [GNU17 Setting] from the property list in the [Properties] dialog box that appears.  

3. Select the target CPU from the [Target CPU] drop-down list. 

4. Click the [OK] button to close the dialog box. 

(5) Build the project. 

Use IDE to build the W23_REMC_RAM_gnu17vx project. 

(6) Connect the equipment and turn on the power. 

1. Connect high voltage DC-DC converter, SVT17W23, ICDmini, USB cable, and PC. 

2. Reset SVT17W23 and ICDmini. 

(7) Run the sample software. 

1. Use IDE to run the W23_REMC_RAM_gnu17vx project. 

2. After starting W23_REMC_RAM_gnu17vx, the EL lamp turns on. 
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4. Software Description 
 
 

4.1.4 Sample Program Operation Overview 

(1) Initialize the system. 

(2) REMC starts to oscillate in a one-shot mode. 

(3) The program halts to wait for an interrupt from REMC. 

(4) When an interrupt occurs from REMC, the program outputs a signal to P00 or restart REMC in a one-shot 
mode according to interrupt causes. 

 

The figure below shows the flow chart: 
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4. Software Description 
 
 

4.1.5 Parameters and Output Waveforms 

The file remc_out.c defines constants to determine output waveforms. These constants can change the count 
values of REMC's timer as shown in the table below: 

Definition name Setup counter 

DIS_CYCLE REMC's DBLEN (cycle length of data signal) 

DIS_LO REMC's APLEN (high level period of data signal) 

CHG_CYCLE REMC's CRPER (carrier signal period) 

CHG_HI REMC's CRDTY (high level period of carrier signal) 

 

The correspondence may be wrong because the DIS_LO's setup counter indicates high level period of data signal 
in the description above. But, since the DIS signal controls, through GPIO's P00 pin, the time when to invert the 
DIS signal by using the REMC's compare match interrupt function, the DIS signal has nothing to do with the 
REMC's internal state.  

REMC's REMO output is for outputting CHG signals. 

Therefore, the DIS signal, timing of CHG signal, and relationship between frequencies are uniquely determined 
as follows by using the MCU's clock frequency Φ = 32.768kHz: 

 

(1) (DIS_CYCLE + C1) / Φ  C1=40 DIS_CYCLE >= DIS_LO + 44 

(2) (DIS_LO + C2) / Φ C2=35 

(3) CHG_CYCLE / Φ 

(4) CHG_HI / Φ 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5  Relationship between output signal waveform and parameter 

 

It is recommended to determine the definition values by checking waveforms with an oscilloscope lest 
disadvantageous waveforms including beard-like waveform are generated. 
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4. Software Description 
 
 

4.2 W23_REMC_ASM_gnu17vx 

This section describes the software W23_REMC_ASM_gnu17vx including a compact program written in 
assembler language in order to test EL drive signals. Note that, if not otherwise specified, this application notes 
describe the blink operation. 

 
4.2.1 File Configuration 

File name Function 

src/boot.c Startup module 

src/main.c Main function 

src/osc.c OSC driver file 

src/osc.h OSC driver header file 

src/remc_asm.s Start, stop, and interrupt functions of REMC waveform output (assembler language) 

src/t16_ch0.c T16 Ch0 driver file 

src/t16_ch0.h T16 Ch0 driver header file 

src/crt0.h Boot processing definition file (for GNU17 Version 3) 

inc/c17w23_reg.h Header file for peripherals 

inc/reg The header file which defined the bit assignment every peripheral circuits 

 
4.2.2 Module Description 

This section describes non-generic setting mainly of function names and functions out of all modules in the files. 

 

File name: remc_asm.s 

Function name Function 

startRemcAsm Initializes and activates REMC, and accepts an interrupt. 

stopRemcAsm Stops REMC, clears interrupt accepted, and sets the outputs to P00 and P16 to "L" 
level. 

intRemcAsm REMC interrupt function. It handles the compare AP/DB interrupts. 

 

File name: t16_ch0.c (the description is provided only for functions used in this software) 

Function name Function 

initT16Ch0 Initializes T16 Ch0. 

startT16Ch0 Starts T16 Ch0. 

intT16Ch0 Interrupts T16 Ch0. Repeats blinks. 
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4. Software Description 
 
 

4.2.3 Global Variable 

This section describes global variables used in the sample program. 

Variable name Type Function 

blink unsigned short Used in a blink mode. 0: turned off, 1: turned on. 

 
4.2.4 Compile Switch 

This section describes compile switches used in the sample program. 

Switch a definition in main.c to change turned-off, turned-on, or blink mode. 

Variable name Function 

EL_LAMP_MODE 0: turned-off, 1: turned-on, 2: blink. 

 

The blink frequency can be changed with the parameter BLINK_INTERVAL_COEF in t16_ch0.c, and the value 
can be calculated in the equation below (unit: second). 

 
Turn-off time = Turn-on time = BLINK_INTERVAL_COEF / 32768 

 

That is, if BLINK_INTERVAL_COEF = 16384 by default, EL lamp repeats to turn on/off in 0.5 sec cycle. 
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4. Software Description 
 
 

4.2.5 Operating Procedures 

The sample software includes two projects for GNU17 Version 2 (hereinafter referred to as GNU17v2) and 
GNU17 Version 3 (hereinafter referred to as GNU17v3). 

(1) Select [Import...] from the [File] menu to start the Import Wizard, then select  

 [General] > [Existing Project to Workspace] (GNU17v2) or  

 [General] > [Existing Projects into Workspace] (GNU17v3).  

(2) Select the project folder that contains the sample program: 

 W23_REMC_ASM_gnu17v2 folder (GNU17v2) or 

 W23_REMC_ASM_gnu17v3 folder (GNU17v3). 

(3) Select [Copy projects into workspace] and then click the [Finish] button to exit the Import Wizard. 

(4) Change the target CPU.  

 (GNU17v2) 

1. Select the imported project in the [C/C++ project] view and select [Properties] from the [Project] menu. 

2. Select [GNU17 General] from the property list in the [Properties] dialog box that appears.  

3. Select the target CPU from the [Target CPU Device] drop-down list. 

4. Click the [OK] button to close the dialog box. 

 (GNU17v3) 

1. Select the imported project in the [Project Explorer] view and select [Properties] from the [Project] 
menu. 

2. Select [GNU17 Setting] from the property list in the [Properties] dialog box that appears.  

3. Select the target CPU from the [Target CPU] drop-down list. 

4. Click the [OK] button to close the dialog box. 

(5) Build the project. 

Use IDE to build the W23_REMC_ASM_gnu17vx project. 

(6) Connect the equipment and turn on the power. 

1. Connect high voltage DC-DC converter, SVT17W23, ICDmini, USB cable, and PC. 

2. Reset SVT17W23 and ICDmini. 

(7) Run the sample software. 

1. Use IDE to run the W23_REMC_ASM_gnu17vx project. 

2. After starting W23_REMC_ASM_gnu17vx, the EL lamp blinks. 
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4. Software Description 
 
 

4.2.6 Sample Program Operation Overview 

(1) Initialize T16 Ch0, GPIO, and REMC. 

(2) Start T16 Ch0. 

(3) The program halts to wait for an interrupt from T16 Ch0. 

(4) When an interrupt from T16 Ch0 occurs, REMC is restarted or stopped to blink according to blinking state. 

(5) When REMC is running, an interrupt occurs regularly for modulating output waveforms, so that a signal is 
output to P00 or REMC is restart according to the interrupt cause. 
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4. Software Description 
 
 

The figure below shows the flow chart: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

startRemcAsm 
startRemcAsm 

RETURN 

Save register 
into stack 

Set 
REMDBCTL.MO

DEN to one 

Set REMCARR 
to a value 

Set 
REMCCTL.CAR 

REN to one 

Set REMC's 
interrupt flag 

Enable REMC's 
interrupt 

Set REMAPLEN  
to a value 

Set REMDBLEN 
to a value 

Reset and start 
REMC 

Restore register 
from stack 

stopRemcAsm 
stopRemcAsm 

Stop REMC 

Reset REMC's 
interrupt flag 

RETURN 

Save register 
into stack 

Output "L" to 
P00 

Restore register 
from stack 

Disable 
REMC's 
interrupt 

T16Ch0 interrupt handling flow 
Interrupt occurs 

blink=0? 

Call 
startRemcAsm 

Yes 

No 

Set blink to 
one 

(turned on) 

Call 
stopRemcAsm 

Set blink to 
zero 

(turned off) 

RETURN 

Clear T16CH0 
interrupt flag 

Flow from initialization to waiting for interrupt 
main 

Set P00 for 
output 

Change P16 
to REMO 

Set REMC's 
Interrupt level 

Reset REMC 

Switch 
operational clock 

to OSC1 

Set blink to 
zero 

(turned off) 

HALT 

Initialize 
T16Ch0 

Start T16Ch0 

Stop IOSC 

Change OSC1  
to a clock for 

REMC 

14  Seiko Epson Corporation S1C17W23 EL Lamp 
Application Notes (Rev. 1.1) 



4. Software Description 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.2.7 Parameters and Output Waveforms 

The file remc_asm.s defines constants to determine output waveforms. The constants can change the counter 
value of REMC timer and have the same specification as described in "4.1.5 Parameters and Output Waveforms." 
However, C1=37 and C2=32. 

 
4.2.8 Sample Program Size 

Of all files of this sample program, remc_asm.s provides three functions which enables REMC to operate EL 
driver: startRemcAsm, stopRemcAsm, and intRemcAsm. So, in order to use remc_asm.s for general purpose, its 
size is shown below: 

File name ROM size used 

remc_asm.s 170Byte 
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APPENDIX A. Experiment Example to Turn on EL Lamp 
 
 

APPENDIX A. Experiment Example to Turn on EL Lamp 

This chapter describes an example which examined how the brightness and various characteristics of an EL lamp 
may actually change according to waveforms. 

First, this chapter describes the circumstance to evaluate luminescence intensity. 

The luminescent intensify of the EL lamp can be measured in cd/m2 as a light source. A dedicated meter 
including a photometer is required for this purpose. But, due to the constraint of available meters and flat light 
source, available light meter is used as the alternative means. 

The specification of the light meter used is as follows: 

•       Minolta digital light meter T-1 

Now, we have examined the change of luminescence intensity of the EL lamp caused by the change of 
waveforms by using BOM components listed in Table 1 in the high voltage DC-DC converter circuit shown in 
Figure 3, so we determined two typical conditions for evaluation. 

 

Table 1  BOM of high voltage DC-DC converter circuit shown in Figure 3 

Name Symbol Manufacturer Product number Specification 

EL Lamp EL1 - - Custom-made 

Transistor Q1 Micro Commercial Co. MMBT5551-TPCT-ND Ic=600mA, Vceo=160V 

Q2 

Diode D1 ON Semicon. BAS21LT3GOSCT-ND 250V, 200mA 

Inductor L1 Abracon Corporation ASPI-0403S-332M-T 3.3mH, 80mA, RDC<=11Ω 

Resistor R1 ROHM MCR01 Series 1kΩ, Size=1005(0402), Tol=F 

R2 1kΩ, Size=1005(0402), Tol=F 

R3 10kΩ, Size=1005(0402), Tol=F 

 

Table 2 lists the meaning of symbols below: 

 

Table 2  Description of symbols 

Symbol Meaning 

Vpeak Peak voltage value applied to the EL lamp. 

Imeas Total current flowing in the driver circuit (Vcc in Figure 3) and S1C17W23. 

Illuminance Measured illuminance of luminescent EL surface. 

Luminous efficiency Value of the illuminance divided by Vcc multiplied by Imeas. 
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APPENDIX A. Experiment Example to Turn on EL Lamp 
 
 

Figure 6 shows the dependency of various characteristics on applied voltage when using setting values under two 
typical conditions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6  Dependency of various characteristics on applied voltage under two typical conditions 

 

In addition, the meters used in the experiment are as follows: 

• Ammeter: Agilent, 34401A, 6 1/2 Digit Multimeter 
• Oscilloscope: Tektronix TDS3014 
• Stabilized power supply: HP E3631A, DC Power Supply 
 

Finally, Figure 7 shows how the lamp emits light when the supply voltages (3.0V, 1.5V) are applied under two 
typical conditions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7  How EL lamp emits light under two typical conditions 

ex_3.0V 

Vcc＝3.0V Vcc＝1.5V 

ex_1.5V 
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